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Theme 1: "Standard software. Microsoft Word text editor. Creating, formatting 

and saving a document, for solving medical problems » 

1. Questions for testing the initial (basic) level of knowledge: 

1. Assign a printer, scanner, keyboard, mouse, monitor. 

2. Assign a text editor. 

3. Components of a personal computer. 

4. Turn the computer on and off. 

5. Management of the desktop. 

6. The purpose and the difference between the icons and labels. 

7. Windows menu types. 

2. Targeted tasks: 
Student must know: 

 • The structure of the main window of 

the text editor MS Word and the 

purpose of the elements of this window. 

 • Ways to create a new and save the 

current Word document. 

 • Basic document parameters: fields, 

page orientation, hyphenation. 

 • Ways to select a sentence and a 

paragraph. 

 • Ways to format the paragraph. 

 • Ways to format text. 

 • Framing the text with lines. 

 • Key shortcuts for fast text formatting. 

 • Set the line spacing. 

The student should be able to: 

• Master the basic tools for processing 

textual information. 

• Configure the main parameters of the 

Word document: fields, page orientation, 

hyphenation. 

• Type in the MS WORD editor text using 

text formatting technology for the 

specified time interval (15-20 minutes). 

Literature: 

1. Stepanov A.N. Computer science. 

Textbook for high schools. 4th ed. St. 

Petersburg, Peter, 2006; 

2. Esaulenko IE, Semenov SN Fundamentals 

of practical informatics in medicine; 

Voronezh, 2005; 

3. Methodological development for a 

practical lesson on the topic "Standard 

software. Microsoft Word text editor. 

Creating, formatting and saving a 

document, for solving medical problems » 

3. Tasks for independent work on the topic: 

1. Describe the main interface elements of the Microsoft Word program window. 

1. Describe the main interface elements of the Microsoft Word program window. 



2. List all ways to highlight a symbol, word, sentence, paragraph and text. 

3. List the keyboard shortcuts used to format the font. 

4. How to increase font size? 

5. How to align text? What kinds of text alignment do you know? 

6. How do I change the spacing between characters? 

7. How do I set the paragraph indents to the left and right, the first line? 

8. One hundred tabulation, how to install it? 

Tests for self-control 

1. Scale rulers are used: 

a) for formatting paragraphs (indent, ledge, left and right border); 

b) for the possibility of placing text in strictly defined places from the left and 

right edges of the paper; 

c) to change the page margins; 



d) to set the line spacing. 

2. Specify the correct keyboard shortcuts: 

a) Cut text - CTRL + X; 

b) Cut text - CTRL + W; 

c) copy text - CTRL + C; 

d) copy text - CTRL + I; 

e) insert text - CTRL + V; 

f) save the document - CTRL + S; 

g) open the document - CTRL + O; 

h) Create a new document - CTRL + N. 

3. For automatic hyphenation, you need to go to: 

a) Page layout → Hyphenation → No; 

b) Page Layout → Hyphenation → Auto; 

c) Page Layout → Hyphenation → Manual. 

4. The Boundary tool is located in the group ... tabs Home: 

a) Font; 

b) Paragraph; 

c) Style; 

d) Editing. 

5. For making single and double horizontal lines, you must type on the empty 

line: 

a) --- and press Enter; 

b) - and press Enter; 

c) === and press Enter; 

d) --- and press CTRL + Enter. 

6. To set the line spacing, you need to activate the window: 

a) Paragraph; 

b) Font; 

c) Editing. 

7. The status bar element, showing the number of pages, words, signs, 

paragraphs and lines, is: 

a) page; 

b) document statistics; 

c) view mode; 

d) Scope of the document. 

8. There are the following basic types of text alignment: 

a) left; 

b) at the top; 

c) on the right; 

d) in width; 

e) height; 

f) in the center; 

9. The following keyboard shortcuts exist to undo or redo the user: 

a) CTRL + Z; 

b) CTRL + R; 



c) CTRL + Y; 

10. To select a word, you must: 

a) double-click the mouse button; 

b) click on any of its words with the Ctrl key pressed; 

c) place the mouse pointer on the left margin of the page and click once; 

d) press and hold the Ctrl key while selecting with the mouse. 

Practical part 

Type the following text in the MS WORD editor without formatting: 

Viral Influenza Do you feel as if you have repeatedly moved the truck? Are 

you so sick that you are afraid to die? Or, rather, are you so sick that you are afraid 

not to die? If the head breaks, the muscles ache, the forehead on fire, then most 

likely you are bitten by a monster called viral influenza. It will continue to torment 

you until it decides to stop it. 

Perhaps it is better to call this insidious virus "a monster with a thousand 

guises". Although there are three main types (viruses A, B and C), they have 

unlimited possibilities to mutate. It's true that a fight with one species will give you 

immunity against this species, but the degenerate form of this virus can lay you on 

both scapulae in the next year or even a little later - in it. 

If you are counting on relief from antibiotics, you will not be lucky, because 

viral influenza is a viral infection, and antibiotics do not kill the virus. The best 

thing you can do is try to ease your suffering. Here's how. 

Naked facts about the virus flu 

How to distinguish a flu from the flu? It's not a problem. And maybe yes. 

Although these diseases and there are similar features and methods of treatment, 

they are caused by completely different organisms. An acute condition with a cold 

usually lasts longer, but with viral flu the state of health is worse. Below is a 

comparison of the general symptoms of the two diseases and the differences 

between them, made by professor of dermatology and toxicology at the Northern 

University in Ohio, Dr. Thomas Gossel. 

Type the following text in the MS WORD editor without formatting: 

PROSTHETICS 

Sooner or later, each of us suffers from a common cold. Whether you are the 

bravest, the strongest, the best, the cleverest, all your virtues are nothing for these 

viruses that turn a person into its own coughing and sneezing shadow. 

The worst thing is that there is no cure for colds: antibiotics, fighting bravely 

with bacterial infections, are powerless against cold viruses. Thus, we 

optimistically squish our noses, perhaps we take a couple of tablets from the cold 

and hope that everything will pass as usual in about a week. 

The Truth About Colds 



So, you have a cold and you wanted to know who or what caused it? Dr. 

Elliott Dick, a virologist and professor at the University of Wisconsin-Madison, 

who has been investigating for over 30 years about the transmission of a cold, 

believes that many suspicious circumstances are involved in this case. These 

include: 

1. taking food or drinks with someone who has a cold; 

2. kiss the patient; 

3. failure to take action against the common cold; 

4. draft; 

5. Walk along the street with a wet head. 

Rest and relax. "Additional rest will give you the opportunity to direct all the 

energy of the body to recovery. It can also help avoid complications such as 

bronchitis or pneumonia, "advises Dr. Samuel Coron, a family doctor specializing 

in preventive medicine. 

No parties! "When you are sick, parties or other entertainment can deplete 

you physically, jeopardize your immune system and prolong the runny nose," says 

Dr. Timothy Van Ert, a San Francisco and Saratoga, California doctor specializing 

in self-medication and preventive medicine . - No fun until you get better! " 

Warm up. Dr. Sehnert advises to fight the cold in heat: 

"It allows our immune system to concentrate on fighting infection, instead of 

spending energy on warming." 

Take a walk. "Moderate exercise improves circulation, helping the immune 

system to distill the antibodies that fight infection," explains Dr. Sehnert. - Jump in 

the room on a small springboard for 15 minutes or walk on the street for 30 

minutes, but refrain from complex exercises: they can tire you. " 

  



Theme 2: "Standard software. Microsoft Word text editor. Tables, 

Formulas, page breaks for solving medical problems » 

 

1. Questions for testing the initial (basic) level of knowledge: 

1. Table in terms of technology for processing textual information. 

2. The unit of the table structure. 

3. The dimension of the table. 

4. Operations with table cells. 

 

2. Targeted tasks: 

The student should know: 

 Principles of tabular structure 

formation. 

 Ways to create a table structure. 

 Ways to navigate the structure of the 

table. 

 The process of filling the created table 

with textual information. 

 Optimal formatting of the table. 

 Ways to highlight the rows / columns 

of the table. 

 Methods of inserting and deleting rows 

/ columns of the table. 

 Ways to copy, move rows / columns of 

the table. 

 Methods of using tabulation in a table 

The student should be able to: 

 Use the capabilities of the Microsoft 

Word word processor to represent and 

process the table data. 

 • Create text electronic documents 

containing tabular data, and give them 

an optimal view. 

Literature: 

1. Stepanov A.N. Computer science. 

Textbook for high schools. 4th ed. St. 

Petersburg, Peter, 2006; 

2. Esaulenko IE, Semenov SN Fundamentals 

of practical informatics in medicine; 

Voronezh, 2005; 

3. Methodological development for a practical 

lesson on the topic "Standard software. 

Microsoft Word text editor. Tables, 

Formulas, page breaks for solving medical 

problems » 

 

3. Tasks for independent work on the topic: 

1. How to create a table structure? Describe the methods you know. 

  



2. How do I move the insertion cursor over the table, select cells? 

 

 

 

 

 

 

3 List ways to highlight the rows / columns of the table. 

 

 

 

 

 

4 How do I insert and delete rows / columns in a table? 

 

 

 

 

 

5 How do I copy, move rows / columns in a table? 

 

 

 

 

6. How are the cells merged and divided? 



7. Define the tabulation of textual information. 

8. List tab types and describe them. 

9. How to insert a symbol into the text? 

10. How to insert a formula? 

11. What is a nested table? 

12. How can I increase or decrease the length of a line using tabulation? 

  



Tests for self-control 

1. What is the dimension of the table and how it is determined: 

a) Font settings and its parameters; 

b) the size of the cells; 

c) the number of rows and columns; 

(d) Scale. 

2. List the main ways to build tables in Word: 

a) using the Add Table tool; 

b) Using the Drawing toolbar; 

c) via the Table → Add Table dialog; 

d) Using the tools in the Toolbox for drawing Tables and Borders. 

3. List ways to highlight a table row in Word: 

a) Edit→ Select all; 

b) Ctrl + Shift + arrow; 

c) Table→Specify → String. 

4. List ways to highlight the table column in Word: 

a) move the mouse pointer over the column and click; 

b) Edit → Select all; 

c) Table→Set → Column. 

5. Specify the order of filling and formatting the table: 

a) fill the header of the table, then proceed with the formatting; 

b) first format the table, then fill in; 

c) first enter all the information, then proceed with the formatting; 

d) does not matter. 

6. List all the options for aligning the text in the cells of the table: 

a) only horizontal; 

b) horizontal and vertical; 

c) only vertical; 

d) either horizontal or vertical. 

7. How to add a term to the table: 

a) Table → Insert→ Rows below; 

b) Insert→ Add Row; 

c) Table →  Add lines → Above; 

d) Table → Insert → Rows above. 

8. How to add a column to the table: 

a) Table→ Add column → Right; 

b) Table →  Insert → Columns on the right; 

c) Table →  Insert → Columns on the left; 

d) Insert → Add Column. 

9. How to delete a row from a table: 

a) Select the line and press Shift + Del; 

b) Table → Delete → Rows; 

c) Edit→ Clear the formats. 

10. How to delete a column from a table: 

a) Edit→ Clear the formats; 



b) Select the column and press Shift + Del; 

c) Table → Delete → Columns. 

11. The Symbol dialog box contains the tabs: 

a. Symbol; 

b. Special signs; 

c. Styles; 

d. Insert. 

12. How to insert a formula? 

a. Insert  → Form; 

b. Insert → Symbol → Formula; 

c. Insert  → Symbol. 

Practical part 

1. Create a document, type and format the table below according to the 

sample. 

Ministry of Health and 
social development 
Russian Federation 

Form code according to OKUD 
 Code of the institution for OKPO 

Medical records 
Name (stamp) of the institution 
Form No. 107-1 \ y 

Approved by order 
Ministry of Health 

social development of the Russian Federation 
of February 12, 2007 No. 110 

 
 

RECIPE» _____ « ____________________ 20 ____ г. 

 

adult  children's  Necessary 
подчеркнуть  

Surname, 
name, 

patronymic 
of the 
patient 

    Age 

    ______ 

   

 

Surname, 
Name 
doctor 

   

   

 

 

 

 

Doctor   
P.S. 

signature and personal stamp 
 

The recipe is valid: 
10 Dday,     2 months,      1 yer 

(unnecessary delete) 
 

 

  

 
 rub 

 
pennies 

 
Rp: 
 
 
 

 
 rub. 

 
pennies. 

 
Rp: 
 
 
 

 
rub. 

 
pennies. 

 
Rp: 
 
 

 



 

2. Create a document, type and format the following formulas according  

to the sample. 

 𝑃0
−1 = ∑

𝜌𝑘

𝑘!
+

𝜌𝑚+1

𝑚!(𝑚−𝜌)
𝑚
𝑘=0   (1) 

 𝜋 = ∑ 𝑃𝑘 =
𝑚𝑚

𝑚!
∑ (

𝜌

𝑚
)∞

𝑘=𝑚

𝑘
∞
𝑘=𝑚 𝑃0 =

𝜌𝑚𝑃0
(𝑚−1)!(𝑚−𝜌)

 (2) 

 𝑃{ 𝛾 > 𝑡 } = 𝑃𝑚𝑒
−𝑚𝜇𝑡 ∑ (

𝜌

𝑚
)
𝑘−𝑚

∞
𝑘=𝑚 ∑ 𝑒−𝑚𝜇𝑡 (𝑚𝜇)𝑠

𝑠!
𝑘−𝑚
𝑠=0  (3) 

 𝑃{ 𝛾 > 𝑡 } = 𝑃𝑚𝑒
−𝑚𝜇 ∑ (

𝜌

𝑚
)
𝑘−𝑚

∞
𝑘=𝑚 ∑ 𝑒−𝑚𝜇𝑡 (𝑚𝜇)𝑠

𝑠!
𝑘−𝑚
𝑠=0  (4) 

 𝐷𝛾 = 𝑀𝛾2 − (𝑀𝛾)2 =
𝜋(2−𝜋)

𝜇2(𝑚−𝜌)2
.  (5) 

  



Theme 3: "Standard software. Using Microsoft Excel to solve medical problems: 

program interface, rows, columns, creating a list » 

 

1. Questions for checking the initial level of knowledge: 

1. Describe the main Microsoft Excel-2007 program window and the main 

elements of the program interface. 

2. What parameters determine the address of the cell? 

3. Describe how to enter information into cells and how to edit information. 

4. What methods of selection of cells do you know? 

5. What methods of editing data in cells are known to you? 

6. What is the spreadsheet workspace, table cells, range of cells? 

7. How to create multi-line text in a cell? 

8. What is AutoFill used for and how is it implemented? 

2. Targeted tasks: 

The student should know: 

 • The main structural elements of the 

spreadsheet interface. 

 • Basic terms of the Excel spreadsheet. 

 • How it works with the spreadsheet. 

 • How to correctly enter information, 

format the data in cells. 

 • How to select, copy and delete data in 

cells. 

The student should be able to: 

 • Possess basic tools for processing text 

and numeric information. 

 • Enter and edit data using the editing 

line and directly in the cells. 

 • Perform calculations by entering 

formulas, copy, delete information. 

 • Set the desired format in the cells of 

the spreadsheet. 

 • Hide rows and columns 

Literature 
1. Esaulenko IE, Semenov SN Fundamentals 

of practical informatics in medicine; 

Voronezh, 2005. 

2. Stepanov A.N. Computer science. Textbook 

for high schools. 4th ed. St. Petersburg, 

Peter, 2006; 

3. Methodological development for a practical 

lesson on the topic "Standard software. 

Using Microsoft Excel to solve medical 

problems: program interface, rows, 

columns, creating a list » 

 

3. Tasks for independent work on the topic: 

1. Define the spreadsheet. 

  



2. What sequence of operations should the user perform to enter the 

formulas? 

3. How can I place text in two lines in one cell? 

4. List the main ways of selecting cells. 

5. List the basic ways of copying cells 

6. How is the cell formatted? 

7. Which groups of formulas exist. Briefly describe. 

8. What is an absolute reference? 

9. What is a relative reference? 

10. What is AutoFill used for and how is it implemented? 

  



Tests for self-control 

1) List all known methods of copying information in the cells of the 
spreadsheet: 

a) using the context menu; 

b) using the keyboard shortcut Shift + Insert; 

c) using the button in the scope of the "Clipboard" tasks; 

d) using the keyboard shortcut Alt + Insert; 

e) using the keyboard shortcut Ctrl + Insert. 

2) How to group rows? 

a) Data → Group; 

b) SHIFT + ALT + RIGHT ARROW; 

c) Data → Group and structure → Group; 

d) SHIFT + ALT + LEFT ARROW. 

3) What kind of software products does the Excel spreadsheet include? 

a) application programs; 

b) programming systems; 

c) system programs. 

4) How do I put text in two lines in one cell? 

a) by pressing the Alt + Enter key combination; 

b) by pressing the keyboard shortcut Ctrl + Enter; 

c) by pressing the keyboard shortcut Shift + Enter; 

d) Press Enter. 

5) To join a group of cells, use the command: 

a) Alignment; 

b) Font; 

c) Data; 

d) Review. 

6) What is MS Excel? 

a) spreadsheet; 

b) a word processor; 

c) image editor. 

7) How do I enter and edit data in a cell? 

a) in the edit line; 

b) in the status bar; 

c) directly in the table cell; 

d) when the F1 key is pressed; 

e) when you press the F2 key. 

8) The spreadsheet sheet has the following dimensions: 

a) 1638 columns, 104857 rows; 

b) 16,384 columns of 1048576 rows; 

c) 1634 columns, 104856 rows; 

9) How can I highlight the entire line? 

a) dragging the mouse; 

b) there is no correct answer; 

c) highlight the line number. 



10) Specify the order in which the formula is entered in the cell: 

a) enter "=" (equal to); 

b) select the cell; 

c) enter into the cell, an arithmetic or boolean expression or function. 

11) Which of the following is not a characteristic of the cell? 

a) Meaning; 

b) Name; 

c) Address; 

d) Size. 

12) How many types of links exist to describe the address of the cell: 

a) 3; 

(b) 1; 

(c) 2; 

(d) 4. 

13) To display hidden rows or columns use the tab: 

a) Insert; 

b) Type; 

c) Data; 

d) Home. 

14) To set a certain type of data alignment in a cell, use the Format tab of the 

Cell Format dialog: 

a) Type; 

b) Border; 

c) Number; 

d) Alignment. 

15) To group rows and columns use the tab: 

a) Data; 

b) Type; 

c) Home; 

d) Insert. 

16) How many sheets the Excel workbook consists of: 

a) 3; 

b) 2; 

(c) 4; 

(d) 1. 

17) The Excel document has the extension: 

a) pptx; 

b) xlsx; 

c) docx; 

d) exe. 

  



Practical part 

1. Calculate by the formulas: 

a. Select the cell, enter the "=" sign and the arithmetic expression 

= 50 * 41/10 + 53. 

Press the Enter key. 

This value should be 258. 

b. Select the cell, enter the "=" sign and the arithmetic expression 

= (100 + 200) * (70-53) 

Press the Enter key. 

The value obtained must be 5100. 

2. Dial the proposed data in the cells according to the sample presented 

below. 

 

 

Enter the 1st formula and calculate: 

= (A3 + B3 * B1) / B2 

Press the Enter key. 

The resulting value should be 16.6. 

Enter the 2nd formula and calculate: 

= B1 + C1 * (B3-C3) 

Press the Enter key. 

The value obtained must be -517. 

  

 А В С 

1 6 8 15 

2 15 3 5 

3 10 5 40 



Theme 4: "Standard software. Microsoft Excel. Use of built-in statistical 

functions to solve medical problems » 

1. Questions for checking the initial level of knowledge: 

1. Ways to call the function wizard. 

2. The purpose of the "Built-in Functions" tool. 

3. Categories of built-in functions. 

4. Give the concept of the range finder. 

5. Give the concept of a range of data. 

2. Targeted tasks: 

The student should know: 

a. Ways to call the function wizard. 

b. The purpose of the Built-in Functions tool. 

c. Categories of built-in functions. 

d. What is the range finder. 

e. What is the range of data 

f. Ways to call the chart wizard. 

g.  What is called the function argument. 

h. Types of charts and their purpose. 

i. What is the range of data. 

j. What is a series of data 

A student must be able to: 

 • Work in the MSEXCEL-2007 

program. 

 • Add functions for calculations of 

various kinds of indicators 

 • Add charts to visualize table 

information. 

 

Literature: 

1. Esaulenko IE, Semenov SN Fundamentals 

of practical informatics in medicine; 

Voronezh, 2005. 

2. Stepanov A.N. Computer science. Textbook 

for high schools. 4th ed. St. Petersburg, 

Peter, 2006; 

3. Methodological development for a practical 

lesson on the topic "Standard software. 

Microsoft Excel. Use of built-in statistical 

functions to solve medical problems » 

1. Tasks for independent work on the topic: 

1. What is the built-in Excel function? 

2. Describe the classification of the built-in functions by the types of data 

being processed. 

3. What can be used as arguments to the built-in function? 

4. What categories of built-in functions refer to special areas. 

5. What is a range finder? Describe the work with it. 

6. How to work with the AutoSumma tool. 

7. Describe the built-in Excel functions that you know. 

8. Why do we need to build charts and diagrams? 

9. What is a series of data? 

10. Describe the process of creating a chart or graph? 

11. List the required elements for the design of any chart and chart? 

12. How do I change the parameters of the created chart? 

13. How can I change the font of text information on a chart? 

14. What is the chart area? How to change its size? 

15. How can I change the line type and color on the graph of the graph? 

Tests for self-control 



 

1) Built-in Excel functions are used for: 

a) calculation of the simplest arithmetic expressions; 

(b) Data operations; 

c) working with the Date and Time; 

d) calculation of logical expressions. 

2) What is a nested function called: 

a) A function that is nested in a folder; 

b) A function that is the argument of another function; 

c) The function is independent of the arguments of the other function; 

d) There is no correct answer. 

3) How can I call the function wizard in Excel? 

a) in the editing line with the button "Insert function"; 

b) the FORMULA tab by the button "Insert function"; 

c) the DATA tab with the "Insert function" button; 

d) the MAIN tab. 

4) According to the type of data processed, the Excel built-in functions are 
classified as: 

a) Text functions; 

b) Mathematical functions; 

c) Functions for processing the date and time; 

d) Logical functions; 

(e) Financial functions; 

(f) Statistical functions. 

5) Which of Excel's built-in functions summarizes the cells that satisfy the 

given condition 

a) ACCOUNTS; 

(b) SUMMARY; 

c) DATE; 

d) SRHCHR. 

6) Which of the built-in Excel functions counts the number of non-empty cells 

that satisfy the specified condition: 

a) ACCOUNTS; 

(b) SUMMARY; 

c) DATE; 

d) SRHCHR. 

7) Which of the built-in functions Excel returns the average of its arguments, 

which can be numbers or names: 

a) ACCOUNTS; 

(b) SUMMARY; 

c) DATE; 

d) SRHCHR. 

8) Why it is necessary to build charts and diagrams 

a) for the development of human creativity; 

b) to visualize the data presented in a tabular form; 



c) to facilitate the perception of information, simplifying the process of comparing 

the presented data. 

9) The schedule is intended for: 

a) an indication of the relative value that is integral; 

b) demonstration of discrete data; 

c) display of the dependence of the function on the argument. 

10) The bar chart is for: 

a) an indication of the relative value constituting a single whole 

b) demonstration of discrete data 

c) displaying the results of comparing one indicator in different conditions 

11) Specify the required elements for the design of any chart and chart: 

a) headings, legend, data signatures; 

b) headings, data series, grid lines; 

c) a data table, axes, a legend. 

12) What is a legend (displayed in charts and graphs of Excel)? 

a) Textual interpretation of the graphically presented data; 

b) Signatures of the X and Y axes; 

c) Text work. 

13) Why, in a standard way, is a chart or chart created almost always in need 

of improvement? 

a) to best present the graphic information, focusing the audience on the really 

important elements of the chart and chart; 

b) to make it more colorful; 

c) in order to interest the audience



1. Create a document, type and format the table below in accordance with the sample. Calculate the indicated by 

the question mark of the cell. Execution time: 20-60 min. 

 

Dial tabular information and arrange it in the same way. 

WORKING TIME TABLE FOR MARCH 2015 

 

Unit: City Hospital No. 1 
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    01 02 03 04 05 06 07 08 09 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31       

1 
Ivanov 

А.А. 
3 

head 

physician 
8 8 В В 8 8 8 В В В 8 8 8 8 8 8 В В 8 8 8 8 8 В В 8 8 8 8 8 В ? 

? ? ? ? ? 

2 
Petrov 

P.P. 
5 paramedic О О О В О О О В В В О О О О О О О В О О О О О О В О О О О О О 

? ? ? ? ? ? 

3 
Koneva 

M.P. 
4 surgeon 8 8 В В 8 8 8 В В В 8 8 8 8 8 8 В В 8 О О О О О В О О О О О О 

? ? ? ? ? ? 

4 
Kallag

ov G.D 
5 therapist 8 8 В В 8 8 8 В В В 8 8 8 8 8 8 В В 8 8 8 8 8 В В 8 8 8 8 8 В 

? ? ? ? ? ? 

5 
Nikola

ev B.P 
5 

otolaryngolog

ist 
О О О В О О О В В В О О О О О О О В О О О О О О В О О О О О О 

? ? ? ? ? ? 

6 
Sokolov

a S.N. 
5 nurse 8 8 В В 8 8 8 В В В 8 8 8 8 8 8 В В 8 8 8 8 8 В В 8 8 8 8 8 В 

? ? ? ? ? ? 

7 
Volkov 

Т.S. 
3 cardiologist 8 8 В В 8 8 8 В В В 8 8 8 8 8 8 В В 8 8 8 8 8 В В 8 8 8 8 8 В 

? ? ? ? ? ? 

8 
Kulesho

va Е.Y 
4 nurse 8 8 В 8 8 8 8 В В В 8 8 8 8 8 8 В В О О О О О О В О О О О О О 

? ? ? ? ? ? 

9 
Eliniko

v Е.Е. 
5 

ophthalmologi

st 
8 8 В В 8 8 8 В В В 8 8 8 8 8 8 В В 8 8 8 8 8 В В 8 8 8 8 8 В 

? ? ? ? ? ? 

1

0 

Orlova 

L.А. 
4 ol. nurse 8 8 В В 8 8 8 В В В 8 8 8 8 8 8 В В 8 8 8 8 8 В В 8 8 8 8 8 В 

? ? ? ? ? ? 

 



1. For work on March 8, payment in double size. 

2. The norm of working time is 21 days (167 hours). 

Note: In - a day off, B - sick leave, O - leave, P – absenteeism



2. Create a document, type and format the table below according to the sample. 

Perform the task specified in this table. Execution time: 30-60 min. 

2. Create a document, type and format the table below according to the sample. 

Perform the task specified in this table. Execution time: 30-60 min. 

The table below shows the values of the conditional indicators at different time 

periods. 

№ пп. 
Name 

indicator 

YEARS 

2012 2013 2014 2015 2016 2017 

1 Indicator 1 27,76 103,70 66,09 59,61 11,62 76,56 

2 Indicator 2 88,63 20,52 78,24 19,63 53,92 74,46 

3 Indicator 3 32,33 62,95 22,79 19,03 68,97 35,33 

4 Indicator 4 55,34 45,13 39,35 73,36 44,96 44,95 

5 Indicator 5 46,45 90,08 43,10 15,51 49,66 91,58 

Required: 

1. Calculate the average for each indicator for the period 2010-2015. 

2. Calculate the sum of the values of the indicators for each year and draw pie 

charts 

3. Create separate bar charts for each indicator. 

4. To create a single column chart to visually compare the change in the 

indicator value by years. 

5. Create graphs of the change in the values of indicators by years 

  



Theme 5: "MS Access. Database organization: by entering data; with the help of a 

wizard; using the constructor, by importing spreadsheet data; creating a multi-table 

database for solving medical problems " 

1. Questions for testing the initial (basic) level of knowledge: 

1. What are Databases? 

2. What is the Database Management System? 

3. Why do you need databases? 

4. Main types of databases? 

 

2. Targeted tasks: 

3. Tasks for independent work on the topic: 

1. What is a Database? 

2. What is MS Access 2010? 

3. List the main features of MS Access 2010. 

4. Define the table, normalization, links and keys. 

5. Define the entity, attribute, and domain. 

6. Describe the types of logical connections. What are they installed for? 

7. What is the key. Describe the types of keys. 

8. List the stages of database design. 

9. Main features of MSAccess 2010. 

Test for self-control: 

1) Relational databases have: 

a) statistical data; 

b) fields of the same properties; 

c) necessarily embedded objects; 

d) related tables. 

2) The subject area is: 

a) an integrated set of structured and interrelated data organized according to certain 

rules; 

The student should know : 

1. What is the Database. 

2. Basic concepts. 

3. Stages of designing databases. 

4. Principles of working with MS Access 

2010. 

 

The student should be able to: 
1. Designing Databases 

2. Represent data in the form of tables. 

3. Identify the key fields. 

4.  Work with MS Access 2010. 

 

Literature 

1.  Stepanov A.N. Computer science. 

Textbook for high schools. 4th ed. St. 

Petersburg, Peter, 2006; 

2. Esaulenko IE, Semenov SN Fundamentals 

of practical informatics in medicine; 

Voronezh, 2005; 

3. Methodological development for a 

practical lesson on the theme "MS Access. 

Database organization: by entering data; 

with the help of a wizard; using the 

constructor, by importing spreadsheet data; 

creating a multi-table database for solving 

medical problems " 



b) this is part of the real world to be studied in order to create a database to automate 

the management process; 

c) This is a collection of software and hardware, methods and people that provide 

collection, storage, processing and delivery of information to solve assigned tasks. 

3) Specify 4 basic data models: 

a) relational; 

b) registration; 

c) hierarchical; 

d) network. 

4) The primary key is: 

a) these are one or more fields (columns) whose combination of values uniquely 

identifies each entry in the table; 

b) one or more fields (columns) in the table that contain a reference to the field or 

fields of the primary key in another table. 

5) A simple key ... 

a) consists of one field; 

b) consists of several fields; 

c) consists of one entry; 

d) consists of several records. 

6) The essence is: 

a) any particular or abstract object in the subject domain; 

b) this property of the object in the domain; 

c) the relationship between objects in the subject area. 

7) Stages of database design: 

a) study of the subject area; 

b) selection of software to create the database; 

c) analysis of data (entities and their attributes); 

d) presentation of data in the form of tables; 

e) definition of relations between entities and definition of primary and secondary 

(external) keys. 

8) Records are: 

a) headings; 

b) columns; 

c) lines; 

d) of the table. 

9) Logical data is: 

a) monetary data; 

(b) Text; 

c) one of two meanings; 

d) numbers. 

10) The auto-build property has a field: 

a) numeric; 

b) a counter; 

c) memo; 

d) logical. 



11) The key field should be: 

a) by all means a meter; 

b) must be numeric; 

c) unique; 

d) should not contain long records. 

12) The tables serve for: 

a) storage of information; 

b) conducting calculations; 

c) retrieval of information; 

d) printing tables. 

13) Links between tables are needed for: 

a) the creation of reports, requests; 

b) to copy data; 

c) ensuring data integrity; 

d) automating the task of making changes. 

  



Practical part 

1. Create an Access database. 

2. Create tables based on the database description provided in the variant of the job. 

The names of the tables to be created must match the names of the tables (entities) 

specified in the variant of the job. 

3. In each table, create the fields. The names of the fields to be created and their data 

types must match the description given in the variant. 

4. Create links between tables in accordance with the variant of the task. For each 

connection, establish support for ensuring data integrity. 

5. Create substitution fields in tables where necessary. 

Check the database schema: make sure that the diagram reflects all the tables and the 

relationships between them. 

Option 1 

The fragments of the database tables are given. Create a Trauma Database and fill in 

the data. Where required, create substitution fields for easy filling of tables. 

Wounds Bleeding 

Cod Type wound 

1 Gunshot 

2 Cutting 

3 Chopped 

5 Bruised 

6 Torn 

7 Crashed 

8 Bitten 

Patients 

Номер Фамилия Имя Отчество 
Дата 

поступления 
Рана Кровотечение 

1 Hubulov Kazbek Petrovich 25.05.1995 Chopped Outer 

2 Petrov Zinaida Alekseevna 27.05.1981 Gunshot Internal 

3 Zaseeva Fatima Arturovna 30.05.1998 Bitten Arterial 

4 Bagaeva Snezhna Victorovna 02.06.1990 Torn Capillary 

5 Rudenko Lidia Ivanovna 07.06.1985 Cutting Parenchymal 

Option 2 

The fragments of the database tables are given. Create a database of the Vaccination 

Cabinet and fill in the data. Where required, create substitution fields for easy filling 

of tables. 

Inoculations 

Cod Name 

1 BCG 

2 AKDS 

3 Polio 

Cod Type bleeding 

1 Arterial 

2 Capillary 

3 Parenchymal 

4 Outer 

5 Internal 



4 Measles 

5 Parotite 

6 Rubella 

7 ADS-M 

8 Whooping cough 

9 Flu 

10 Botkin 

Children 

CodChilde Surname Name FatherName Date of Birth 

1 Bocharova Vera Sergeevna 20.04.2005 

2 Petrov Andrei Aleksandrovich 27.05.2003 

3 Gabueva Indira Alanovna 30.01.2001 

4 Kunduxova Georgii Georgievich 31.12.2006 

5 Kubalova Carina Zaurbekovna 01.05.2004 

Prevention 

Cod CodChilde CodPrevention Date of vaccination 

1 Bocharova Rubella 12.06.06 

2 Petrov Flu 17.09.06 

3 Gabueva Whooping cough 13.08.06 

4 Kunduxova Botkin 10.10.06 

5 Kubalova ADS-M 11.12.06 

 

  



Theme 6: "Standard software. Presentations in the MS PowerPoint environment. 

Interface, the main elements and possibilities for solving medical problems » 

1. Questions for testing (basic) level of knowledge: 

1. What is PowerPoint for? 

2. What is the purpose of the presentation? 

3. What are the advantages of electronic presentations in comparison with 

other types of presentations? 

2. Targeted tasks: 

The student should know: 

 • Purpose and features of the 

PowerPoint program. 

 • What kinds of presentations exist? 

 • Stages of creating a presentation. 

 • The main elements of the PowerPoint 

interface. 

 • Ways to create presentations. 

 • The process of creating a presentation 

using the Auto Content Wizard. 

 • The process of creating a presentation 

using the design template. 

 • Basics of working with slides (adding 

and deleting slides, changing the order 

of slides, changing the layout of slides). 

The student should be able to: 

 • Use the PowerPoint application to 

create presentations. 

 • Create presentations of a specific 

structure and kind, and give them an 

optimal view 

Литература 

1. Stepanov A.N. Computer science. 

Textbook for high schools. 4th ed. St. 

Petersburg, Peter, 2006; 

2. Esaulenko IE, Semenov SN 

Fundamentals of practical informatics 

in medicine; Voronezh, 2005. 

3. Methodological development for a 

practical lesson on the topic "Standard 

software. Presentations in the MS 

PowerPoint environment. Interface, the 

main elements and possibilities for 

solving medical problems » 

3. Tasks for independent work on the topic: 

1. List the interface elements of the PowerPoint program. 

2. What are the different kinds of presentations in PowerPoint? 

3. Describe the stages of creating a presentation in PowerPoint. 

4. What are the viewing modes in PowerPoint? Describe them. How to switch 

between modes? 

5. What objects can be placed on the PowerPoint slide? 

Test for self-control 

1) Can I change the background color for each slide? 

a) yes; 



b) no; 

c) never. 

2) How to add a picture to the slide? 

a) Insert - drawing; 

b) editing - drawing; 

c) file is a picture. 

3) A slide is ... 

a) the symbol of the presentation; 

b) the main element of the presentation; 

c) the paragraph of the presentation; 

d) The presentation line. 

4) How to insert a new slide? 

a) on the Edit menu, click Create Slide; 

b) on the Slides tab, click the slide thumbnail and press the Esc key; 

c) on the Slides tab, click the slide thumbnail and press the Enter key; 

d) On the Show Slides menu, click Create Slide.  

5) Customize the animation of the picture 

a) Select picture - Slide show - Animation settings - Add effect; 

b) Customize the animation - Add effect; 

c) Add effect - Customize animation - Slide show - Select picture. 

6) To delete the text, the picture from the slide, it is necessary ... 

a) highlight it and press the ESC key; 

b) click on the object; 

c) select it and press the DELETE key; 

d) erase. 

7) Launching a slide show 

a) presentation presentation; 

(b) F6; 

(c) F5; 

d) add an effect. 



8) Method of launching Microsoft PowerPoint 

a) with a triple click on the Microsoft PowerPoint document icon; 

b) left-click on an empty area of the workspace - create - Microsoft PowerPoint 

presentation; 

c) Start-All Programs - Microsoft Office - Microsoft PowerPoint; 

d) using the office. 

9) Setting the slide change effects 

a) slide show - animation setting - add effect; 

b) add an effect - customize the animation - show slides; 

c) slide show - slide change - select an effect - select the speed - click or 

automatically. 

10) How do I exit the presentation view? 

a) F5; 

b) Esc; 

c) Enter; 

d) Delete. 

11) PowerPoint is ... 

a) Animation intended for the preparation of presentations and slide films; 

b) a program designed to prepare presentations and slide films; 

c) a text editor; 

d) a program for editing texts and drawings. 

12) Elements of the PowerPoint interface 

a) title, menu, status bar, task area, etc .; 

b) word, paragraph, line; 

c) the monitor screen; 

d) The system unit. 

13) Types of filling 

a) gradient, pattern, texture, pattern; 

b) background, color; 

c) picture, picture; 



d) the inscription.  

  



Practical part 

Create a presentation using themes and sample slides according to the proposed 

sample: 

Sterilization and Disinfection

A Nursing Responsibility

Marie Rathe, APRN, FNP-BC, CNOR, CRNFA

 

  



Topic 7: "The means of the Internet for the search for professional information on 

specific sections of medical knowledge. Search engines" 

1. Questions for testing the initial (basic) level of knowledge: 

1. What is a computer network? 

2. Classification of computer networks. 

3. What is the Internet service? 

4. What are search indexes? 

 

1. Targeted tasks: 

The student should know: 

• What is a computer network. 

• Types of computer networks. 

• Methods of data transmission. 

• Domain name system. 

• Internet services. 

• Protocols. 

• Internet Explorer 

 

The student should be able to: 

• Work with the computer. 

• Work in the browser. 

• Find the information that interests him. 

Literature 

1. Gelman V.Ya., Shulga OA, Buzanov 

D.V. Internet in medicine, 2005 MIA 

2. Medical resources of the Internet: A 

reference book. ... - m .: des com, 2000. 

3. Internet for the doctor. Sinitsyn V.Ye., 

Timonina E.A. 

4. Methodical development for a practical 

lesson on the topic "The means of the 

Internet to search for professional 

information on specific sections of medical 

knowledge. Search engines" 

 

3. Tasks for independent work on the topic: 

1. Describe the process of information retrieval. 

2. Describe the main types of search. 

3. Describe the Google search system. 

4. Describe the search engine "Yandex". 

5. Describe the search system "Yahoo". 

Test for self-control 

1) The most common way to find information on the Internet involves the 

use of: 

a) a text editor; 



b) reference systems; 

c) hyperlinks; 

d) search engines; 

e) Handbooks. 

2) In Russia search engines are: 

a) rambler (www.rambler.ru); 

b) Yandex (www.yandex.ru); 

c) mail (www.mail.ru); 

d) an aport (www.oport.ru); 

e) google (www.google.com); 

f). All of the above.  

3) The search for information is understood as: 

a) receiving information by e-mail; 

(b) the transfer of information over long distances through computer systems; 

c) sorting information; 

d) reading fiction; 

e) obtaining the necessary information by monitoring the actual reality, using 

directories, archives, reference systems, computer networks, databases and 

knowledge bases. 

4) A computer that provides services to other computers on the network 

(clients). 

a) the server; 

b) the provider; 

c) a computer with a search engine; 

d) host computer; 

e) There is no correct answer. 

5) On-line is: 

a) information network; 

b) the team; 

c) real-time mode; 



d) the utility; 

e) search mode. 

6) The global computer network is: 

a) information system with hyperlinks; 

b) the set of computers connected by information transfer channels and located 

within the same building premises; 

c) a set of host computers and file servers; 

d) a system for exchanging information on a specific topic; 

e) a set of local networks and computers located at large distances and 

connected by means of communication channels into a single system. 

7) The first means of long-distance communication is considered to be: 

a) radio communication; 

b) telephone; 

c) Telegraph; 

d) mail; 

e) Computer networks. 

8) A computer connected to the Internet must have: 

a) the domain name; 

b) WEB-page; 

c) IP address; 

d) URL; 

e) Home WEB page. 

9) The browser is 

a) Microsoft Internet Explorer 

b) Opera 

c) Chrome 

d) All of the above 

e) There are no correct answers 

10) To connect a computer to the Internet, use: 

a) modem; 



b) plotter; 

c) the scanner; 

d) printer; 

e) There is no correct answer. 

 

Practical part 

Using various search engines, find information on cardiovascular diseases. 

Topic 8: "The means of the Internet to search for professional information 

on specific sections of medical knowledge. Library Information Systems » 

1. Questions for testing the initial (basic) level of knowledge: 

1. What is an electronic library? 

2. Why is it necessary to create an EB? 

3. What is the difference between different library systems? 

 

2. Targeted tasks: 

The student should know: 

• Basic definitions and terms. 

• Differences between catalogs and 

medical libraries. 

• How to search for medical resources. 

• Difference between scientific EB and 

educational EB. 

 

The student should be able to: 

• Use summary directories. 

• Use medical libraries. 

• Use scientific DL 

• Use educational EB. 

• Use medical reference books and drug 

catalogs. 

Literature 

1. Gelman V.Ya., Shulga OA, Buzanov 

D.V. Internet in medicine, 2005 MIA 

2. Medical resources of the Internet: A 

reference book. ... - m .: des com, 2000. 

3. Internet for the doctor. Sinitsyn V.Ye., 

Timonina E.A. 

4. Methodical development for a practical 

lesson on the topic "The means of the 

Internet to search for professional 

information on specific sections of 

medical knowledge. Library 

Information Systems » 

 

3. Tasks for independent work on the topic: 

1. List the main functions of electronic libraries. 



2. List the main tasks of the electronic library. 

3. Criteria for the evaluation of scientific EB. 

4. The main objectives of the creation of scientific EB. 

5. The main functions of scientific EB. 

6. The main goals of creating educational EE. 



7. Functions of educational EB. 

7. Functions of educational EB. 

8. Describe one medical library system. 

Test for self-control 

1) The most common way to find information on the Internet involves the use of: 

a) a text editor; 

b) reference systems; 

c) hyperlinks; 

d) search engines; 

e) Handbooks. 

2) In Russia search engines are: 

a) rambler (www.rambler.ru); 

b) Yandex (www.yandex.ru); 

c) mail (www.mail.ru); 



d) an aport (www.oport.ru); 

e) google (www.google.com); 

f) All of the above. 

3) The integration of information resources is understood as: 

a) their combination with the purpose of using various information with 

preservation of its properties, features of presentation and user possibilities of 

manipulation with it; 

b) the ability of the user to find the information of interest to him with the 

greatest completeness and accuracy with the least expenditure of effort in the 

entire accessible information space. 

4) The criteria for evaluating EB are: 

a) scope of application; 

b) Functionality; 

c) visual characteristics; 

d) the nature and content of information resources; 

e) the nature and content of the site interface; 

f) methods and technologies used. 

5) The electronic catalog is ... 

a) This is a collection of lexicographic databases, i.e. a set of dictionaries, 

formed according to individual elements of the bibliographic description; 

b) a collection of data located in a file combined by the purpose of the stored 

information. 

c) a database containing bibliographic descriptions of documents (books, 

journals, articles, dissertations, electronic and audiovisual documents); 

d) It is a library catalog in machine-readable form, operating in real time, 

available to readers. 

6) How is information retrieved on search engines? 

a) the list of servers sorted by subject; 

b) by matching keywords with words on pages; 

c) the text of the signatures to the figures and page titles; 



d) all options are correct. 

  



Practical part 

Using Medical Library Systems, find the relevant information: 

a. on cardiovascular diseases. 

b. about anemia in children: causes, symptoms, treatment. 

c. about the disease of toxoplasmosis, and also get information about 

hereditary diseases, 

d. about Aspirin and withdraw it. 

The information found is saved in the MS WORD file. 

  



Theme 9: "Algorithm for modeling physiological processes for solving clinical 

problems. Information management systems for a medical-prophylactic institution 

(AIS) 

1. Questions for checking the initial level of knowledge: 

1. The concept of algorithm, modeling, physiological process. 

2. The concept of the simulation model. 

2. Targeted tasks: 

The student should know: 

• Basic concepts and definitions of 

modeling of physiological processes. 

• The principle of constructing a dynamic 

model. 

• Purpose of AIS. 

• The main modules of information 

management systems of a medical and 

preventive institution. 

• What functions AIS should provide. 

• What are the tasks of the AIS of the 

health facility? 

The student should be able to: 

 Forecast the proposed situation. 

 Create a simulation model. 

 Work with the hospital "Hospital" 

system. 

 To start and register the AIS of the 

hospital "Hospital". 

  To keep records of cases of 

hospitalization in the hospital 

"Hospital". 

Literature: 

1. Korbinsky B.A. / T.V. Zarubina 

Medical Informatics. - 2 nd ed., Sr. - 

Moscow: Publishing Center 

"Academy", 2012. -192 p. 

2. Esaulenko IE, Semenov SN 

Fundamentals of practical informatics 

in medicine; Voronezh, 2005 

3. 3. Methodological development for 

practical lesson on the theme 

"Algorithm for modeling physiological 

processes for solving clinical problems. 

Information management systems for a 

medical-prophylactic institution (AIS) 

3. Tasks for independent work on the topic: 

1. Describe briefly the process of modeling the process using MS Exel. 

2. How does the registration in the AIS "Hospital" take place? Describe this 

process. 

3. How is the new patient registered in the AIS "Hospital". 

4. How to access the window for viewing / editing information about 

hospitalization cases. 

5. What is the "Information about the patient" mode intended for? 

Tests for self-control: 

1) What is called the attribute of the object? 



a) representation of a real-world object with the help of some set of its 

characteristics, essential for solving this information problem; 

b) the abstraction of real-world objects, united by common characteristics and 

behavior; 

c) the relationship between the object and its characteristics; 

d) each individual characteristic common to all possible specimens. 

2) The choice of model type depends on: 

a) the physical nature of the object; 

b) the purpose of the facility; 

c) the objectives of the facility survey; 

d) the information essence of the object. 

3) What is the information model of the object? 

a) a material or mental representation of an object that replaces the original 

object in the process of research while preserving the most essential properties 

important for this study; 

b) a formalized description of the object in the form of text in some coding 

language containing all the necessary information about the object; 

c) software that implements the mathematical model; 

d) a description of the attributes of objects that are essential for the problem 

under consideration and the relationships between them. 

4) Specify the classification of models in the narrow sense of the word: 

a) natural, abstract, verbal; 

b) abstract, mathematical, informational; 

c) mathematical, computer, information; 

d) verbal, mathematical, informational. 

5) The purpose of creating an information model is: 

a) processing of data on a real-world object taking into account the relationship 

between objects; 

b) the complexity of the model, taking into account additional factors that were 

previously informed; 



c) research of objects, based on computer experimentation with their 

mathematical models; 

d) representation of the object in the form of text in some artificial language, 

accessible to computer processing. 

6) Information modeling is based on: 

a) designation and name of the facility; 

b) replacement of the real object with the model corresponding to it; 

c) finding an analytical solution that gives information about the object under 

investigation. 

7) Formalization is: 

a) the stage of transition from a meaningful description of the links between 

the identified features of the object to a description using some encoding 

language; 

b) replacement of a real object with a sign or a collection of signs; 

c) the transition from fuzzy tasks that arise in real reality to formal information 

models; 

d) the allocation of material information about the site. 

8) Information technology is called: 

a) a process determined by a combination of means and methods of processing, 

manufacturing, changing the state, properties, form of the material; 

b) changing the initial state of the object; 

c) a process using a combination of means and methods for processing and 

transmitting primary information of a new quality about the state of the object, 

process or phenomenon; 

d) the totality of certain actions aimed at achieving the stated goal. 

9) What is called simulation simulation? 

a) research method related to computer technology; 

b) modern technology of object research; 

c) a method that allows the construction of models describing processes in the 

way they actually went; 



d) implementation of the mathematical model in the form of a software tool. 

10) What is a computer information model? 

a) representation of the object as a test in some artificial language, accessible to 

computer processing; 

b) a set of information characterizing the properties and condition of the object, 

as well as the relationship with the outside world; 

c) model in mind or in conversation, implemented on the computer; 

d) research method related to computer technology. 

11) Computer experiment consists of a sequence of stages: 

a) choice of the numerical method - development of the algorithm - execution 

of the program on the computer; 

b) constructing a mathematical model - choosing a numerical method - 

developing an algorithm - executing the program on the computer, analyzing 

the solution; 

c) model development - algorithm development - algorithm implementation in 

the form of software; 

d) construction of a mathematical model - development of an algorithm - 

program execution on a computer, solution analysis. 

Practical part 

30-year-old woman, was taken to the clinic of the NSR with complaints of 

sweating, tremors and drowsiness, mood swings, tearfulness, general weakness, 

migraine pain throughout the body. The patient has type 1 diabetes mellitus (DM 1), 

identified 15 years ago, a severe course with constantly changing therapy due to 

recurrent hyper- and hypoglycemia. At admission, the blood glucose level was 1.2 

mmol / l. According to the patient, during the week she noted a low level of glucose 

in the blood, although insulin at that time was not introduced. 

The patient was diagnosed with diabetic macro- and microangiopathy 

(neuropathy, retinopathy). Concomitant diseases: Hashimoto's thyroiditis (in the 

phase of hypothyroidism) on replacement therapy with L-thyroxine; and 

osteoporosis, which is why she takes calcium and vitamin D. Family history: 



diabetes, ischemic heart disease, in the elder sister - a severe UPU with repeated 

surgical interventions (died at the age of 23 years). 

The patient first received inpatient treatment and examination 5 years ago and 

during this period the reason for hospitalization has always been poor control of 

diabetes. 2 years ago, after severe transient hypoglycemia, all hormonal tests (without 

pathology) were made in the clinic, the insulin dose was reduced and the patient was 

transferred to insulin analogues. Despite the changes in therapy, diabetes mellitus 

remained poorly controlled - from severe hypoglycemia to hyperglycemia more than 

30 mmol / l. 

When examined at admission: the general condition of moderate severity, the 

mood is suppressed. Reduction of subcutaneous fat, lipodystrophy zones under 

hyperpigmented skin. The body mass index is 16.7 kg / m2 (height 166 cm, weight 

46 kg). Palpitation rhythmic with a heart rate of 110 beats / min, noises are not 

listened. Blood pressure 90/60 mm Hg. Pulse on peripheral arteries of weak filling. In 

the lungs, the breath is vesicular, there is no wheezing. CHDD 17 per minute. The 

abdomen is soft, painless. Diuresis is adequate. 

During hospitalization, there were episodes of hypoglycemia with a blood 

glucose level of 1-2 mmol / L with loss of consciousness, which required almost 

continuous glucose infusion (insulin was not injected), during these attacks, the levels 

of C-peptide, insulin, glucose blood: 

Episodes 
Glucose 

(mmol / l) 

Insulin 

(mkEd / l) 

C-peptide (ng 

/ ml) 

1 1.2 20 - 

2 2.1 302 0.014 

3 2.8 63 0.26 

 

In the clinical analysis of the blood: Hb 123 g / l, Erythrocytes 4,0х1012 / l, 

leukocytes 9,9х109 / l, platelets 325х109 / l, ESR 44 mm / h. 

In the biochemical blood test: protein 69 g / l, cholesterol 4.21 mmol / l, 

creatinine 73 μmol / l, ALT 31 units / l, AST 35 units / l, HbA1c 8.8%. Blood 

electrolytes: K + 4.5 mmol / l, Na + 140 mmol / l, Cl-107 mmol / l 



Clinical analysis of urine: ud. weight 1025, pH 6, glucose otr, ketones otr, 

erythrocytes 0, leukocytes 5-6 in sp. 

Glycemic profile: 

Day 

Blood glucose (mmol / L) 

Before 

breakfast 

Before 

lunch 

2 hours 

after lunch 

Before 

bedtime 

1 4,5 1,2 2,6 3,3 

2 1,0 - 2,0 4,9 

3 - - - 14,4 

4 24,5 2,8 - 1,9 

5 1,6 1,9 3,1 5,0 

6 18 6,8 8,4 6,1 

7 - 3,9 4,6 4,1 

8 11,1 4,0 16,0 12,0 

 

  



Topic 10: "Workstation automated workstation (AWP) of the 

physician department doctor - basic functions and principles of work" 

1. Questions for testing the initial (basic) level of knowledge: 

1. What tasks does the physician's workstation solve, what is the convenience 

of using it? 

2. What are the two main integral groups of functions of the physician's 

workstation you know? 

3. List the main functions of the physician's workstation 

4. List the main functions of the hospital physician's workstation 

5. What is the difference between the hospital physician's workstation and the 

physician's office workstation? 

2. Targeted tasks: 

The student should know: 

• What is a physician's surgery 

• Main functions of the physician's 

workstation 

• Types of ARMs in the treatment 

department and how this is conditioned. 

• Principle of operation of the physician's 

workstation. 

 

The student should be able to: 

On the example of the physician's 

workplace: 

• Configure the workstation 

• Use patient search in the workstation 

• Plan patient admission 

• Fill in and print out help 

• Work with the patient's journal. 

Literature 

 

1. Korbinsky B.A. / T.V. Zarubina 

Medical Informatics. - 2 nd ed., Sr. - 

Moscow: Publishing Center 

"Academy", 2012. -192 p. 

2. Methodological development for a 

practical lesson on the topic 

"Workstation automated workstation 

(ARM) of the physician department 

doctor - the main functions and 

principles of work" 

 

3. Tasks for independent work on the topic: 

1. What is the peculiarity of a physician's workstation? Why there is no sense in 

"specialized" ARMs? 

2. Describe the process of working with the outpatient journal. 

3. How to search for a patient on the database. 

4. Describe the process of creating the final forms in the physician's workstation. 

Tests for self-control: 

 



1) MIS is: 

a) a set of software and hardware, databases and knowledge designed to automate 

the various processes taking place in the health facility and the health care 

system; 

b) a combination of software and hardware to automate the various processes 

taking place in the health facility and the health care system; 

c) a set of software databases and knowledge designed to automate the various 

processes taking place in the health facility and the health care system; 

d) a combination of software and hardware, databases and knowledge intended to 

automate various processes. 

2) The AIS reanimation and intensive care database is based on: 

a) MS Excel tables; 

b) MS Word; 

c) MS Access; 

d) MS WordPad. 

3) Intensive care cards and their templates are based on ... 

a) MS Excel tables; 

b) MS Word; 

c) MS Access; 

d) MS WordPad. 

4) To start working with AIS "ORIT" run the file: 

a) RDB_v2.0.mdb; 

b) RDB_v2.0.xls; 

c) RDB_v2.0.dbf; 

d) RDB_v2.0.exe. 

5) The database settings form consists of: 

a) a list of hospital departments; 

b) a list of polyclinic offices; 

c) a list of complications; 

d) a list of causes of death; 



e) a list of reasons for hospitalization; 

f) the task manager; 

g) linked table manager. 

6) You can change the list of patients: 

a) by changing the filtering parameters in the "main function buttons" line; 

b) by changing the filtering parameters in the "search string"; 

c) selecting the "reports and forms" tab; 

d) by pressing the F2 key. 

7) The Add New Patient Wizard opens: 

a) by pressing the button "New patient" in the main form; 

b) by pressing the F2 key; 

c) by pressing the F4 key; 

d) by pressing the F7 key. 

8) In what form can you edit (change) the erroneously entered data? 

a) in the main form; 

b) in the form of an extract; 

c) in the form of patient details; 

d) in the form of database settings. 

9) Under the IT cards, the system understands 

a) an Access database based on an IT map template; 

b) an Excel spreadsheet created by the database based on the IT map template. 

10) When working with IT cards use the buttons in the upper right corner of 

the map: 

a) a new day; 

b) designate; 

c) cancel; 

d) printing; 

e) bolus; 

f) mark. bolus; 

g) delete. 



 

Practical part 

Add a new patient to the physician's workstation, enter data about the disease, 

plan the next patient's appointment. 

  



Theme 11: "Principles of constructing specialized information and 

technological systems for the separation of a hospital based on the example of 

an automated information system for the intensive care unit" 

1. Questions for testing the initial (basic) level of knowledge: 

1. What is an automated information system (AIS)? 

2. How is AIS used in medicine? 

3. What is AIS "ORIT"? 

4. What are the tasks of the AIS "Orit" 

5. How do you start working with the "ORIT" system? 

6. What documents does the system work with? List them. 

2. Targeted tasks: 

The student should know: 

 Structure of the main window of the 

automated system 

 Initial database configuration 

 Enter patient information. 

 Patient search by database. 

 The patient's statement. 

 Completing the patient details form 

 Create and edit a document from a 

template 

 Work with intensive care cards 

The student should be able to: 

 Run the "ORITE" program 

 Orient in the interface of the program 

 Search and work with records in the 

database 

 Set up and edit the database 

 Print necessary documents for printing 

Literature: 

 

1. Korbinsky B.A. / T.V. Zarubina Medical 

Informatics. - 2 nd ed., Sr. - Moscow: 

Publishing Center "Academy", 2012. -192 

p. 

2. Esaulenko IE, Semenov SN Fundamentals 

of practical informatics in medicine; 

Voronezh, 2005 

3. Methodological development for practical 

training on the topic "Principles of 

constructing specialized information and 

technological systems for the separation 

of a hospital based on the example of an 

automated information system for the 

intensive care unit" 

 

3. Tasks for independent work on the topic: 

1. Describe the process of introducing a new patient into the database. 

2. Describe the process of patient discharge 

3. Describe the process of creating a document from a template 

Tests for self-control 

1) The workstation automated workstation (AWP) is intended for: 

a) for conducting case histories; 



b) storage of the case histories; 

c) reporting; 

d. All of the above. 

2) The functions of the physician's AWS are divided into categories: 

a) basic and inalienable; 

b) auxiliary; 

c) integral and auxiliary; 

d) basic and auxiliary. 

3) The basis of the ARM is ... 

a) the patient's card; 

(b) Electronic medical history; 

c) electronic medical chart; 

d) a patient's medical insurance policy. 

4) In order to enter personal data into the treatment program of the 

treatment department, it is necessary to use the team 

a) Tools- Settings; 

b) Service-Data Entry; 

c) Service-History; 

d) Service - Medcart. 

5) Which tab of the "Program Settings" window contains data about doctors 

and nurses? 

a) the tab "Cabinet"; 

b) the Doctors tab; 

c) The Branch tab; 

d) Directions tab. 

6) Which tab contains data for template filling in forms? 

a) the tab "Medical institution"; 

b) the Doctors tab; 

c) The Branch tab; 

d) Directions tab. 



7) Main application window: 

a) electronic medical chart; 

b) an outpatient clinic; 

c) medical history; 

d) Journal of dispensary patients. 

8) Which team is used to view the number of patients admitted for a certain 

interval? 

a) File - Medical examination; 

b) File-Report Forms; 

c) File-Results of work; 

d) File- Search for the patient.  

  



Practical part 

Add a new patient to the database, fill out a form for detailed information about 

the patient. Find the patient's database indicated by the teacher and write it out. 

  



Topic 12: "Information medical systems of diagnostic services (departments of 

functional diagnostics and laboratory studies)" 

 

1. Questions for checking the initial level of knowledge: 

1. What basic documents are provided in the Integrated Medical Information 

System (KIIS)? 

2. What information does the patient's electronic medical record contain? 

3. What is the Laboratory Information System and what is the purpose of its 

implementation? 

 

2. Targeted tasks: 

The student should know: 

1. What are the information medical 

systems of diagnostic services and what 

are they intended for. 

2. What is the Radiological Information 

System (RIS) and its main tasks. 

3. What is the laboratory information 

system its main functions and purpose. 

The student should be able to: 

1. Work with medical information systems. 

2. Use the functionality of the IC. 

 

Literature 

1. B.A.B. Kobrin Medical Informatics 

2. Esaulenko IE, Semenov SN 

Fundamentals of practical informatics in 

medicine; Voronezh, 2005 

3. Methodological development for a 

practical lesson on the topic 

"Information medical systems of 

diagnostic services (departments of 

functional diagnostics and laboratory 

studies)" 

3. Tasks for independent work on the topic: 

1. How users work with the laboratory subsystem. 

2. How to work with the form of the laboratory order. 

Test for self-control. 

1) The diagnostic service system is designed for: 

a) automation of the work of the staff of diagnostic rooms; 

b) simplifying the formation of conclusions; 

c) image archiving; 

d) instant access to the archives of research; 

e) archiving of spreadsheets. 

2) In the subsystem of diagnostic services IMIS (Integrated Medical Information 

System) the following basic documents are provided: 



a) Functional diagnostics; 

b) Neurofunctional diagnostics; 

c) Sound diagnostics; 

d) Ultrasound diagnosis; 

e) Neural diagnosis; 

f) Endoscopic diagnosis; 

g) Endometrial diagnosis. 

3) To exclude modification of responses after their approval, the capabilities of 

the security subsystem are used: 

a) EDS; 

b) signature; 

c) restriction of access; 

d) limited list of persons. 

4) The basic information is stored in: 

a) reports; 

b) formalized forms; 

c) summary tables; 

d) in all listed. 

5) In special databases, research results can be stored in various formats: 

a) exe, bat; 

b) JPEG, GIF, TIFF, BMP; 

c) AVI, MPEG, ASF; 

d) WAV, MP3; 

e) xls, xlsx. 

Practical communication 

Using a laboratory information system, place a laboratory order. 

  



Theme 13: "ARM physician functional diagnostics and laboratory assistant - the 

basic functions and principles of work" 

 

1. Questions for checking the initial level of knowledge: 

1. What determines the medical focus of computer diagnostic systems. 

2. List the main functional capabilities of the ARM physicians diagnostov. 

3. What is the purpose of the "Functional Diagnostics Protocol Editor" 

program. 

 

2. Targeted tasks: 

The student should know: 

• What are the information medical 

systems of diagnostic services and what 

are they intended for. 

• The main functionality of the ARM of 

diagnostic doctors 

• The work of the "Functional Diagnostics 

Protocol Editor" program 

The student should know: 

 What are the medical systems of diagnostic 

services. 

 The main function of the ARM of 

diagnostic doctors 

 The work of the "Functional Diagnostics 

Protocol Editor" program 

Literature 

1. B.A.B. Kobrin Medical Informatics 

2. Esaulenko IE, Semenov SN Fundamentals 

of practical informatics in medicine; 

Voronezh, 2005 

3. Methodological development for a practical 

lesson on the topic "Information medical 

systems of diagnostic services (departments 

of functional diagnostics and laboratory 

studies)" 

3. Tasks for independent work on the topic: 

1. How do I start the "Protocol Editor" program? 

2. Describe the process of adding a new study to the program. 

3. Describe how to choose the next study. 

4. Describe how to create a new protocol. 

5. How to generate a report? 

6. How do I print a report? 

Test for self-control. 

1) The diagnostic service system is designed for: 

a) automation of the work of the staff of diagnostic rooms; 

b) simplifying the formation of conclusions; 



c) image archiving; 

d) instant access to the archives of research; 

e) archiving of spreadsheets. 

2) To add a new study, you must: 

a) in the study tree, select the Research group with the mouse; 

b) select the General group in the study tree; 

c) select the mouse in the study tree; 

d) In the study tree select the Additional fields group. 

3) In order to filter the elements of the patient tree, you should use the 

command: 

a) Settings → Filtering; 

b) Settings → Filter patients; 

c) Settings → Filter the patient tree; 

d) Settings → Tree filtering. 

4) The basic information is stored in: 

a) reports; 

b) formalized forms; 

c) summary tables; 

d) in all listed. 

5) The Comment field of the Field groups dialog ... To start adding new 

fields, you should: 

a) used for display in the protocol; 

b) used to specify the height of the group; 

c) Used to specify the number of columns in a group. 

Practical communication 

1. In the program "Protocol Editor" add a new study "Ultrasound of the joints." 

2. Add a new patient: Mikhailov Leonid Nikolaevich, born in 1967, number of 

outpatient card 3452, channel of hospitalization 

3. Create a new protocol for this patient. 

4. Form a report on this patient. 



Topic 14: "Information systems for health management at the territorial level" 

1. Questions for testing the initial (basic) level of knowledge: 

1. What determines the medical orientation of IIAs? 

2. List the main functionality of IIAs. 

3. List the groups of analyzed indicators. 

2. Targeted tasks: 

The student should know: 

 Goals, objectives, structure, basic 

functions and principles of development of 

automated information systems for 

municipal, territorial, federal levels of 

health care. 

 The main sources of information. 

 Groups of analyzed indicators 

The student should be able to: 

 Present and process data in IIAs. 

 • Work with IIAs of different levels. 

 

 

Literature 

1. Korbinsky B.A. / T.V. Zarubina Medical 

Informatics. - 2 nd ed., Sr. - Moscow: 

Publishing Center "Academy", 2012. -

192 p. 

1. Methodological development for the 

practical lesson on "Information systems 

for health management of the territorial 

level" 

3. Tasks for independent work on the topic: 

1. What is the Territorial Medical Information System? 

2. The main groups of territorial IIAs. 

3. Three-level system of electronic document management. 

4. Stages of making managerial decisions based on available information. 

5. What is the information-analytical system. 

6. The need to use analytical modules within the territorial IIAs. 

7. What are geographical information systems? 

8. List the main elements of the GIS structure. 

9. The need to use geographic modules within the territorial IIAs. 

Tests for self-control: 

1) The territorial medical information system is: 

a) an integrated system for collecting, processing, transferring and storing data 

on the health status of the population, the environment, the material and 



technical base and the economic aspects of the functioning of the health service 

of the region; 

b) It is a system that provides, along with the processes of collecting, 

accumulating, storing, searching and statistical processing of information, a 

formal content analysis of data based on the construction of models necessary 

for assessing the state and planning the development of a service for 

conducting case histories; 

c) It is a system of visual representation of geographically or co-ordinate 

"anchored" problem-oriented information. storage of case histories. 

2) Information systems of the territorial health department ... 

a) provide inter-hospital interaction for remote consultations, departure of 

specialists and evacuation of patients with the aim of providing highly 

qualified and specialized medical care; 

b) provide information support for planning and controlling the financing of 

medical institutions through the MHI system; 

c) accumulate and process information on the work of all medical institutions 

of the territory. 

3) The basis of the ARM is ... 

a) the patient's card; 

(b) Electronic medical history; 

c) electronic medical chart; 

d) a patient's medical insurance policy. 

4) Under the life cycle of software IP is usually understood: 

a) a continuous process that begins with the decision to create a system and 

ends at the point of decommissioning; 

b) an ongoing process that begins with the decision to create a system and ends 

at the time it is put into operation; 

c) a continuous process that begins at the time of its commissioning and ends at 

the time of its decommissioning; 

5) The information and analytical system is: the tab "Cabinet"; 



a) an integrated system for collecting, processing, transferring and storing data 

on the health status of the population, the environment, the material and 

technical base and the economic aspects of the functioning of the health service 

of the region; 

b) It is a system that provides, along with the processes of collecting, 

accumulating, storing, searching and statistical processing of information, a 

formal content analysis of data based on the construction of models necessary 

for assessing the state and planning the development of a service for 

conducting case histories; 

c) It is a system of visual representation of geographically or co-ordinate 

"anchored" problem-oriented information. storage of case histories. 

6) Geographic information system is: the tab "Doctors"; 

a) an integrated system for collecting, processing, transferring and storing data 

on the health status of the population, the environment, the material and 

technical base and the economic aspects of the functioning of the health service 

of the region; 

b) It is a system that provides, along with the processes of collecting, 

accumulating, storing, searching and statistical processing of information, a 

formal content analysis of data based on the construction of models necessary 

for assessing the state and planning the development of a service for 

conducting case histories; 

c) It is a system of visual representation of geographically or co-ordinate 

"anchored" problem-oriented information. storage of case histories. 

7) The main elements of the GIS structure are: 

a) data entry and storage mechanisms; 

b) Separating the raw data into stable groups by classifying "without a teacher" 

or clustering; 

c) assessing the information content of the grouped data relative to the set of 

known reference objects, i.e. recognition of images with training on standards 

("with the teacher"); 



d) structural and logical research and classification of logical connections. 

e) spatial analysis of objects using a special package of application programs; 

f) output of analysis results. 

 

Practical part 

Add a new patient to the database, fill out a form for detailed information 

about the patient. Find the patient's database indicated by the teacher and write 

it out. 


